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Program Kompresi - Dekompresi Deflate 

 

'Kompresi & Dekompresi DEFLATE 

'------------------------------- 
'(c) 2008, Valentinus Henry G 
'valentz_18@yahoo.com 
 

Option Explicit 
Private WithEvents Huffman As Class1 
Public jnsKmprs As Integer 
Public wktMulai As Single 
Public enkdLZ As String 
Public dekdLZ As String 
 
Private Sub Combo1_Click() 

    If Combo1.Text = "Deflate" Then 
        jnsKmprs = Combo1.ListIndex 
    ElseIf Combo1.Text = "LZ77" Then 
        jnsKmprs = Combo1.ListIndex 

    ElseIf Combo1.Text = "Huffman" Then 
        jnsKmprs = Combo1.ListIndex 
    Else 
    End If 
End Sub 
 
Private Sub Command1_Click() 
Dim pjgfile As Long 

Dim datanya As String 
Dim z As Integer 
Dim sama As Byte 
Dim frasa1 As String 

Dim frasa2 As String 
Dim i As Long 
Dim letak As Long 
Dim enkdHuf As String 

Dim hslLZ As String 
     
    'memanggil kondisiAwal 
    kondisiAwal 

              
    If jnsKmprs = 0 Then 
        'membaca file 
        Label10.Caption = "Baca File" 

        List1.Clear 
        pjgfile = FileLen(Text1.Text) 
        Open Text1.Text For Input As #1 
        Do While Not EOF(1) 

            Line Input #1, datanya 
            List1.AddItem (datanya) 
        Loop 
        Close #1 
     
        'menyimpan hasil kompresi LZ77 
        enkdLZ = Left(Text1.Text, Len(Text1.Text) - 4) + "(kompresi).def" 
        Open enkdLZ For Output As #2 
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        Text2.Text = "" 
        Label10.Caption = "Kompresi LZ77" 
         

        'menyimpan waktu mulai 
        wktMulai = Timer 
         
        'kompresi LZ77 

        For z = 0 To List1.ListCount - 1 
            Text3.Text = List1.List(z)          'window look-ahead buffer 
            hslLZ = "" 
            Do 

                sama = 0                        'tidak ada di kamus 
                 
                'mencari frasa yang sama 
                If Len(Text3.Text) > 30 Then 
                    For i = 0 To 29 
                        frasa1 = Mid(Text3.Text, 1, 30 - i) 
                        frasa2 = Text2.Text 
                        letak = InStr(1, frasa2, frasa1, vbBinaryCompare) 

                         
                        If letak > 0 Then 
                            sama = 1 
                            Exit For 

                        End If 
                    Next i 
                Else 
                    For i = 0 To Len(Text3.Text) - 1 
                        frasa1 = Mid(Text3.Text, 1, Len(Text3.Text) - i) 
                        frasa2 = Text2.Text 
                        letak = InStr(1, frasa2, frasa1, vbBinaryCompare) 
                         

                        If letak > 0 Then 
                            sama = 1 
                            Exit For 
                        End If 

                    Next i 
                End If 
                                
                If sama = 0 Then                'bila tidak ada di kamus 
                    hslLZ = hslLZ + "0," + Left(Text3.Text, 1) 
                    Text2.Text = Text2.Text + Left(Text3.Text, 1) 
                    Text3.Text = Mid(Text3.Text, 2) 
                Else                            'bila ada di kamus 

                    hslLZ = hslLZ + Mid(Str(letak), 2) + "," + Mid(Str(Len(frasa1)), 2) + "," + 
Mid(Text3.Text, Len(frasa1) + 1, 1) 

                    Text2.Text = Text2.Text + Left(Text3.Text, Len(frasa1) + 1) 
                    Text3.Text = Mid(Text3.Text, Len(frasa1) + 2) 

                End If 
            Loop While Len(Text3.Text) > 0 
             
            If Len(hslLZ) > 1024 Then 
                Print #2, Mid(hslLZ, 1, 1023) + String(1, 10) 
                Print #2, Mid(hslLZ, 1024) 
            Else 
                If z = List1.ListCount - 1 Then 
                    Print #2, hslLZ; 
                Else 
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                    Print #2, hslLZ 
                End If 
            End If 

        Next z 
         
        Close #2 
        Label10.Caption = "Kompresi Huffman" 

         
        'kompresi Huffman 
        Call Huffman.EncodeFile(enkdLZ, enkdLZ) 
         

        'memanggil kondisiAkhir 
        kondisiAkhir1 
     
    ElseIf jnsKmprs = 1 Then 
         'membaca file 
        Label10.Caption = "Baca File" 
        List1.Clear 
        pjgfile = FileLen(Text1.Text) 

        Open Text1.Text For Input As #1 
        Do While Not EOF(1) 
            Line Input #1, datanya 
            List1.AddItem (datanya) 

        Loop 
        Close #1 
         
        'menyimpan hasil kompresi LZ77 
        enkdLZ = Left(Text1.Text, Len(Text1.Text) - 4) + "(kompresi).lz7" 
        Open enkdLZ For Output As #3 
            
        Text2.Text = "" 

        Label10.Caption = "Kompresi LZ77" 
         
        'menyimpan waktu mulai 
        wktMulai = Timer 

         
        'kompresi LZ77 
        For z = 0 To List1.ListCount - 1 
            Text3.Text = List1.List(z)          'window look-ahead buffer 
            hslLZ = "" 
            Do 
                sama = 0                        'tidak ada di kamus 
                 

                'mencari frasa yang sama 
                If Len(Text3.Text) > 30 Then 
                    For i = 0 To 29 
                        frasa1 = Mid(Text3.Text, 1, 30 - i) 

                        frasa2 = Text2.Text 
                        letak = InStr(1, frasa2, frasa1, vbBinaryCompare) 
                         
                        If letak > 0 Then 
                            sama = 1 
                            Exit For 
                        End If 
                    Next i 
                Else 
                    For i = 0 To Len(Text3.Text) - 1 
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                        frasa1 = Mid(Text3.Text, 1, Len(Text3.Text) - i) 
                        frasa2 = Text2.Text 
                        letak = InStr(1, frasa2, frasa1, vbBinaryCompare) 

                         
                        If letak > 0 Then 
                            sama = 1 
                            Exit For 

                        End If 
                    Next i 
                End If 
                 

                If sama = 0 Then                'bila tidak ada di kamus 
                    hslLZ = hslLZ + "0," + Left(Text3.Text, 1) 
                    Text2.Text = Text2.Text + Left(Text3.Text, 1) 
                    Text3.Text = Mid(Text3.Text, 2) 
                Else                            'bila ada di kamus 
                    hslLZ = hslLZ + Mid(Str(letak), 2) + "," + Mid(Str(Len(frasa1)), 2) + "," + 

Mid(Text3.Text, Len(frasa1) + 1, 1) 
                    Text2.Text = Text2.Text + Left(Text3.Text, Len(frasa1) + 1) 

                    Text3.Text = Mid(Text3.Text, Len(frasa1) + 2) 
                End If 
            Loop While Len(Text3.Text) > 0 
                                     

            If Len(hslLZ) > 1024 Then 
                Print #3, Mid(hslLZ, 1, 1023) + String(1, 10) 
                Print #3, Mid(hslLZ, 1024) 
            Else 
                If z = List1.ListCount - 1 Then 
                    Print #3, hslLZ; 
                Else 
                    Print #3, hslLZ 

                End If 
            End If 
        Next z 
         

        Close #3 
         
        'memanggil kondisiAkhir 
        kondisiAkhir1 
         
    ElseIf jnsKmprs = 2 Then 
        Label10.Caption = "Kompresi Huffman" 
         

        'menyimpan waktu mulai 
        wktMulai = Timer 
         
        enkdHuf = Text1.Text 

        enkdLZ = Left(Text1.Text, Len(Text1.Text) - 4) + "(kompresi).huf" 
                 
        'kompresi Huffman 
        Call Huffman.EncodeFile(enkdHuf, enkdLZ) 
         
        'memanggil kondisiAkhir 
        kondisiAkhir1 
         
    ElseIf Combo1.ListIndex = -1 Then 
        MsgBox "Pilihlah jenis metodenya terlebih dahulu", vbInformation, "Deflate" 
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    Else 
    End If 
End Sub 

 
Private Sub Command2_Click() 
Dim pjgfile As Long 
Dim datanya As String 

Dim y As Integer 
Dim kode As String 
Dim kode1 As String 
Dim kode2 As String 

Dim mulai As String 
Dim panj As String 
Dim smbl As String 
Dim d As Integer 
Dim hslLZ As String 
 
    'memanggil kondisiAwal 
    kondisiAwal 

             
    If jnsKmprs = 0 Then 
        Label10.Caption = "Dekompresi Huffman" 
             

        dekdLZ = Left(Text1.Text, Len(Text1.Text) - 3) + "txt" 
         
        'menyimpan waktu mulai 
        wktMulai = Timer 
             
        'dekompresi Huffman 
        Call Huffman.DecodeFile(Text1.Text, dekdLZ) 
           

        'membaca file 
        Label10.Caption = "Baca File" 
        List1.Clear 
        pjgfile = FileLen(dekdLZ) 

        Open dekdLZ For Input As #1 
        Do While Not EOF(1) 
            Line Input #1, datanya 
            List1.AddItem (datanya) 
        Loop 
        Close #1 
     
        Text2.Text = "" 

        Label10.Caption = "Dekompresi LZ77" 
            
        'menyimpan hasil dekompresi LZ77 
        Open dekdLZ For Output As #2 

         
        'dekompresi LZ77 
        For y = 0 To List1.ListCount - 1 
            hslLZ = "" 
             
            If Mid(List1.List(y), Len(List1.List(y))) = String(1, 10) Then 
                kode = Left(List1.List(y), Len(List1.List(y)) - 1) + List1.List(y + 1)      'kode 1 baris 
                y = y + 1 
            Else 
                kode = List1.List(y)    'kode 1 baris 
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            End If 
             
            kode1 = kode 

            Do 
                d = InStr(1, kode1, ",", vbTextCompare) 
                    
                If kode1 = "0," Then 

                    Exit Do 
                Else 
                    If Left(kode1, 1) = 0 Then      'bila tidak ada di kamus 
                        hslLZ = hslLZ + Mid(kode1, d + 1, 1) 

                        Text2.Text = Text2.Text + Mid(kode1, d + 1, 1) 
                        kode1 = Mid(kode1, d + 2) 
                    Else                            'bila ada di kamus 
                        mulai = Left(kode1, d - 1) 
                        kode2 = Mid(kode1, d + 1) 
                        d = InStr(1, kode2, ",", vbTextCompare) 
                        panj = Left(kode2, d - 1) 
                        If (Len(kode2) - d) >= 1 Then 

                            smbl = Mid(kode2, d + 1, 1) 
                        Else 
                            smbl = "" 
                        End If 

                        hslLZ = hslLZ + Mid(Text2.Text, mulai, panj) + smbl 
                        Text2.Text = Text2.Text + Mid(Text2.Text, mulai, panj) + smbl 
                        kode1 = Mid(kode2, d + 2) 
                    End If 
                End If 
            Loop While kode1 <> "" 
             
            If y = List1.ListCount - 1 Then 

                Print #2, hslLZ; 
            Else 
                Print #2, hslLZ 
            End If 

        Next y 
         
        Close #2 
         
        'memanggil kondisiAkhir 
        kondisiAkhir2 
         
    ElseIf jnsKmprs = 1 Then 

                       
        dekdLZ = Left(Text1.Text, Len(Text1.Text) - 3) + "txt" 
           
        'membaca file 

        Label10.Caption = "Baca File" 
        List1.Clear 
        pjgfile = FileLen(Text1.Text) 
        Open Text1.Text For Input As #1 
        Do While Not EOF(1) 
            Line Input #1, datanya 
            List1.AddItem (datanya) 
        Loop 
        Close #1 
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        Text2.Text = "" 
        Label10.Caption = "Dekompresi LZ77" 
         

        'menyimpan waktu mulai 
        wktMulai = Timer 
            
        'menyimpan hasil dekompresi LZ77 

        Open dekdLZ For Output As #3 
         
        'dekompresi LZ77 
        For y = 0 To List1.ListCount - 1 

            hslLZ = "" 
             
            If Mid(List1.List(y), Len(List1.List(y))) = String(1, 10) Then 
                kode = Left(List1.List(y), Len(List1.List(y)) - 1) + List1.List(y + 1)      'kode 1 baris 
                y = y + 1 
            Else 
                kode = List1.List(y)    'kode 1 baris 
            End If 

             
            kode1 = kode 
            Do 
                d = InStr(1, kode1, ",", vbTextCompare) 

                    
                If kode1 = "0," Then 
                    Exit Do 
                Else 
                    If Left(kode1, 1) = 0 Then      'bila tidak ada di kamus 
                        hslLZ = hslLZ + Mid(kode1, d + 1, 1) 
                        Text2.Text = Text2.Text + Mid(kode1, d + 1, 1) 
                        kode1 = Mid(kode1, d + 2) 

                    Else                            'bila ada di kamus 
                        mulai = Left(kode1, d - 1) 
                        kode2 = Mid(kode1, d + 1) 
                        d = InStr(1, kode2, ",", vbTextCompare) 

                        panj = Left(kode2, d - 1) 
                        If (Len(kode2) - d) >= 1 Then 
                            smbl = Mid(kode2, d + 1, 1) 
                        Else 
                            smbl = "" 
                        End If 
                        hslLZ = hslLZ + Mid(Text2.Text, mulai, panj) + smbl 
                        Text2.Text = Text2.Text + Mid(Text2.Text, mulai, panj) + smbl 

                        kode1 = Mid(kode2, d + 2) 
                    End If 
                End If 
            Loop While kode1 <> "" 

             
            If y = List1.ListCount - 1 Then 
                Print #3, hslLZ; 
            Else 
                Print #3, hslLZ 
            End If 
        Next y 
         
        Close #3 
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        'memanggil kondisiAkhir 
        kondisiAkhir2 
         

    ElseIf jnsKmprs = 2 Then 
        Label10.Caption = "Dekompresi Huffman" 
             
        'menyimpan waktu mulai 

        wktMulai = Timer 
             
        dekdLZ = Left(Text1.Text, Len(Text1.Text) - 3) + "txt" 
                     

        'dekompresi Huffman 
        Call Huffman.DecodeFile(Text1.Text, dekdLZ) 
         
        'memanggil kondisiAkhir 
        kondisiAkhir2 
    Else 
    End If 
End Sub 

 
Private Sub Command3_Click() 
    CommonDialog1.Filter = "Text Files (*.txt)|*.txt|LZ77, Huffman atau Deflate Files 

(*.lz7,*.huf,*.def)|*.lz7;*.huf;*.def" 

    CommonDialog1.ShowOpen 
    Text1.Text = CommonDialog1.Filename 
     
    If Text1.Text = "" Then 
    Else 
        If FileLen(Text1.Text) = 0 Then 
            MsgBox "File kosong tidak akan dikompresi. Coba file lainnya", vbInformation, "Deflate" 
            Command1.Enabled = False 

            Command2.Enabled = False 
            jnsKmprs = 3 
        Else 
            If Mid(Text1.Text, Len(Text1.Text) - 2) = "txt" Then 

            'jika file .txt maka hanya dapat dikompresi 
                Command1.Enabled = True 
                Command2.Enabled = False 
                Combo1.Enabled = True 
                'jnsKmprs = 3 
            ElseIf Mid(Text1.Text, Len(Text1.Text) - 2) = "def" Then 
            'jika file .def maka hanya dapat didekompresi 
                Command1.Enabled = False 

                Command2.Enabled = True 
                jnsKmprs = 0 
            ElseIf Mid(Text1.Text, Len(Text1.Text) - 2) = "lz7" Then 
            'jika file .lz7 maka hanya dapat didekompresi 

                Command1.Enabled = False 
                Command2.Enabled = True 
                jnsKmprs = 1 
            ElseIf Mid(Text1.Text, Len(Text1.Text) - 2) = "huf" Then 
            'jika file .huf maka hanya dapat didekompresi 
                Command1.Enabled = False 
                Command2.Enabled = True 
                jnsKmprs = 2 
            Else 
            'jika file lainnya tidak dapat diproses 
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                Command1.Enabled = False 
                Command2.Enabled = False 
                jnsKmprs = 3 

            End If 
        End If 
    End If 
End Sub 

 
Private Sub Form_Load() 
    Label10.Caption = "Siap" 
    Combo1.AddItem "Deflate" 

    Combo1.AddItem "LZ77" 
    Combo1.AddItem "Huffman" 
    Set Huffman = New Class1 
    jnsKmprs = 3 
End Sub 
 
Private Sub kondisiAwal() 
    Label2.Caption = "0 detik" 

    Label4.Caption = "0 Bytes" 
    Label6.Caption = "0 Bytes" 
    Label8.Caption = "0 %" 
End Sub 

 
Private Sub kondisiAkhir1() 
    Label2.Caption = Abs(Timer - wktMulai) & " detik" 
    Label4.Caption = FileLen(Text1.Text) & " Bytes" 
    Label6.Caption = FileLen(enkdLZ) & " Bytes" 
    Label8.Caption = Int(FileLen(Text1.Text) / FileLen(enkdLZ) * 100) & " %" 
    MsgBox "Kompresi Selesai", vbInformation, "Deflate" 
     

    Command1.Enabled = False 
    Command2.Enabled = False 
    Combo1.Enabled = False 
    Text1.Text = "" 

End Sub 
 
Private Sub kondisiAkhir2() 
    Label2.Caption = Abs(Timer - wktMulai) & " detik" 
    Label4.Caption = FileLen(Text1.Text) & " Bytes" 
    Label6.Caption = FileLen(dekdLZ) & " Bytes" 
    Label8.Caption = "" 
    MsgBox "Dekompresi Selesai", vbInformation, "Deflate" 

     
    Command1.Enabled = False 
    Command2.Enabled = False 
    Combo1.Enabled = False 

    Text1.Text = "" 
End Sub 
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Modul Kompresi - Dekompresi Huffman 

 

'Huffman Encoding/Decoding Class 

'------------------------------- 
' 
'(c) 2000, Fredrik Qvarfort 
' 

 
Option Explicit 
 
'Progress Values for the encoding routine 
Private Const PROGRESS_CALCFREQUENCY = 7 
Private Const PROGRESS_CALCCRC = 5 
Private Const PROGRESS_ENCODING = 88 
 

'Progress Values for the decoding routine 
Private Const PROGRESS_DECODING = 89 
Private Const PROGRESS_CHECKCRC = 11 
 

'Events 
Event Progress(Procent As Integer) 
 
Private Type HUFFMANTREE 
  ParentNode As Integer 
  RightNode As Integer 
  LeftNode As Integer 
  Value As Integer 

  Weight As Long 
End Type 
 
Private Type ByteArray 

  Count As Byte 
  Data() As Byte 
End Type 
 

Private Declare Sub CopyMem Lib "kernel32" Alias "RtlMoveMemory" (Destination As Any, 
Source As Any, ByVal Length As Long) 
 
Public Sub EncodeFile(SourceFile As String, DestFile As String) 

 
  Dim ByteArray() As Byte 
  Dim Filenr As Integer 
   

  'Make sure the source file exists 
  If (Not FileExist(SourceFile)) Then 
    Err.Raise vbObjectError, "clsHuffman.EncodeFile()", "Source file does not exist" 
  End If 

   
  'Read the data from the sourcefile 
  Filenr = FreeFile 
  Open SourceFile For Binary As #Filenr 
  ReDim ByteArray(0 To LOF(Filenr) - 1) 
  Get #Filenr, , ByteArray() 
  Close #Filenr 
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  'Compress the data 
  Call EncodeByte(ByteArray(), UBound(ByteArray) + 1) 
   

  'If the destination file exist we need to 
  'destroy it because opening it as binary 
  'will not clear the old data 
  If (FileExist(DestFile)) Then Kill DestFile 

   
  'Save the destination string 
  Open DestFile For Binary As #Filenr 
  Put #Filenr, , ByteArray() 

  Close #Filenr 
 
End Sub 
Public Sub DecodeFile(SourceFile As String, DestFile As String) 
 
  Dim ByteArray() As Byte 
  Dim Filenr As Integer 
   

  'Make sure the source file exists 
  If (Not FileExist(SourceFile)) Then 
    Err.Raise vbObjectError, "clsHuffman.DecodeFile()", "Source file does not exist" 
  End If 

   
  'Read the data from the sourcefile 
  Filenr = FreeFile 
  Open SourceFile For Binary As #Filenr 
  ReDim ByteArray(0 To LOF(Filenr) - 1) 
  Get #Filenr, , ByteArray() 
  Close #Filenr 
   

  'Uncompress the data 
  Call DecodeByte(ByteArray(), UBound(ByteArray) + 1) 
   
  'If the destination file exist we need to 

  'destroy it because opening it as binary 
  'will not clear the old data 
  If (FileExist(DestFile)) Then Kill DestFile 
   
  'Save the destination string 
  Open DestFile For Binary As #Filenr 
  Put #Filenr, , ByteArray() 
  Close #Filenr 

 
End Sub 
Private Sub CreateTree(Nodes() As HUFFMANTREE, NodesCount As Long, Char As Long, 
Bytes As ByteArray) 

 
  Dim a As Integer 
  Dim NodeIndex As Long 
   
  NodeIndex = 0 
  For a = 0 To (Bytes.Count - 1) 
    If (Bytes.Data(a) = 0) Then 
      'Left node 
      If (Nodes(NodeIndex).LeftNode = -1) Then 
        Nodes(NodeIndex).LeftNode = NodesCount 
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        Nodes(NodesCount).ParentNode = NodeIndex 
        Nodes(NodesCount).LeftNode = -1 
        Nodes(NodesCount).RightNode = -1 

        Nodes(NodesCount).Value = -1 
        NodesCount = NodesCount + 1 
      End If 
      NodeIndex = Nodes(NodeIndex).LeftNode 

    ElseIf (Bytes.Data(a) = 1) Then 
      'Right node 
      If (Nodes(NodeIndex).RightNode = -1) Then 
        Nodes(NodeIndex).RightNode = NodesCount 

        Nodes(NodesCount).ParentNode = NodeIndex 
        Nodes(NodesCount).LeftNode = -1 
        Nodes(NodesCount).RightNode = -1 
        Nodes(NodesCount).Value = -1 
        NodesCount = NodesCount + 1 
      End If 
      NodeIndex = Nodes(NodeIndex).RightNode 
    Else 

      Stop 
    End If 
  Next 
   

  Nodes(NodeIndex).Value = Char 
 
End Sub 
Public Sub EncodeByte(ByteArray() As Byte, ByteLen As Long) 
   
  Dim i As Long 
  Dim j As Long 
  Dim Char As Byte 

  Dim BitPos As Byte 
  Dim lNode1 As Long 
  Dim lNode2 As Long 
  Dim lNodes As Long 

  Dim lLength As Long 
  Dim Count As Integer 
  Dim lWeight1 As Long 
  Dim lWeight2 As Long 
  Dim Result() As Byte 
  Dim ByteValue As Byte 
  Dim ResultLen As Long 
  Dim Bytes As ByteArray 

  Dim NodesCount As Integer 
  Dim NewProgress As Integer 
  Dim CurrProgress As Integer 
  Dim BitValue(0 To 7) As Byte 

  Dim CharCount(0 To 255) As Long 
  Dim Nodes(0 To 511) As HUFFMANTREE 
  Dim CharValue(0 To 255) As ByteArray 
   
  'If the source string is empty or contains 
  'only one character we return it uncompressed 
  'with the prefix string "HEO" & vbCr 
  If (ByteLen = 0) Then 
    ReDim Preserve ByteArray(0 To ByteLen + 3) 
    If (ByteLen > 0) Then 
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      Call CopyMem(ByteArray(4), ByteArray(0), ByteLen) 
    End If 
    ByteArray(0) = 72 '"H" 

    ByteArray(1) = 69 '"E" 
    ByteArray(2) = 48 '"0" 
    ByteArray(3) = 13 'vbCr 
    Exit Sub 

  End If 
   
  'Create the temporary result array and make 
  'space for identifier, checksum, textlen and 

  'the ASCII values inside the Huffman Tree 
  ReDim Result(0 To 522) 
   
  'Prefix the destination string with the 
  '"HE3" & vbCr identification string 
  Result(0) = 72 
  Result(1) = 69 
  Result(2) = 51 

  Result(3) = 13 
  ResultLen = 4 
   
  'Count the frequency of each ASCII code 

  For i = 0 To (ByteLen - 1) 
    CharCount(ByteArray(i)) = CharCount(ByteArray(i)) + 1 
    If (i Mod 1000 = 0) Then 
      NewProgress = i / ByteLen * PROGRESS_CALCFREQUENCY 
      If (NewProgress <> CurrProgress) Then 
        CurrProgress = NewProgress 
        RaiseEvent Progress(CurrProgress) 
      End If 

    End If 
  Next 
   
  'Create a leaf for each character 

  For i = 0 To 255 
    If (CharCount(i) > 0) Then 
      With Nodes(NodesCount) 
        .Weight = CharCount(i) 
        .Value = i 
        .LeftNode = -1 
        .RightNode = -1 
        .ParentNode = -1 

      End With 
      NodesCount = NodesCount + 1 
    End If 
  Next 

   
  'Create the Huffman Tree 
  For lNodes = NodesCount To 2 Step -1 
    'Get the two leafs with the smallest weights 
    lNode1 = -1: lNode2 = -1 
    For i = 0 To (NodesCount - 1) 
      If (Nodes(i).ParentNode = -1) Then 
        If (lNode1 = -1) Then 
          lWeight1 = Nodes(i).Weight 
          lNode1 = i 
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        ElseIf (lNode2 = -1) Then 
          lWeight2 = Nodes(i).Weight 
          lNode2 = i 

        ElseIf (Nodes(i).Weight < lWeight1) Then 
          If (Nodes(i).Weight < lWeight2) Then 
            If (lWeight1 < lWeight2) Then 
              lWeight2 = Nodes(i).Weight 

              lNode2 = i 
            Else 
              lWeight1 = Nodes(i).Weight 
              lNode1 = i 

            End If 
          Else 
            lWeight1 = Nodes(i).Weight 
            lNode1 = i 
          End If 
        ElseIf (Nodes(i).Weight < lWeight2) Then 
          lWeight2 = Nodes(i).Weight 
          lNode2 = i 

        End If 
      End If 
    Next 
     

    'Create a new leaf 
    With Nodes(NodesCount) 
      .Weight = lWeight1 + lWeight2 
      .LeftNode = lNode1 
      .RightNode = lNode2 
      .ParentNode = -1 
      .Value = -1 
    End With 

     
    'Set the parentnodes of the two leafs 
    Nodes(lNode1).ParentNode = NodesCount 
    Nodes(lNode2).ParentNode = NodesCount 

     
    'Increase the node counter 
    NodesCount = NodesCount + 1 
  Next 
 
  'Traverse the tree to get the bit sequence 
  'for each character, make temporary room in 
  'the data array to hold max theoretical size 

  ReDim Bytes.Data(0 To 255) 
  Call CreateBitSequences(Nodes(), NodesCount - 1, Bytes, CharValue) 
   
  'Calculate the length of the destination 

  'string after encoding 
  For i = 0 To 255 
    If (CharCount(i) > 0) Then 
      lLength = lLength + CharValue(i).Count * CharCount(i) 
    End If 
  Next 
  lLength = IIf(lLength Mod 8 = 0, lLength \ 8, lLength \ 8 + 1) 
   
  'If the destination is larger than the source 
  'string we leave it uncompressed and prefix 
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  'it with a 4 byte header ("HE0" & vbCr) 
  If ((lLength = 0) Or (lLength > ByteLen)) Then 
    ReDim Preserve ByteArray(0 To ByteLen + 3) 

    Call CopyMem(ByteArray(4), ByteArray(0), ByteLen) 
    ByteArray(0) = 72 
    ByteArray(1) = 69 
    ByteArray(2) = 48 

    ByteArray(3) = 13 
    Exit Sub 
  End If 
   

  'Add a simple checksum value to the result 
  'header for corruption identification 
  Char = 0 
  For i = 0 To (ByteLen - 1) 
    Char = Char Xor ByteArray(i) 
    If (i Mod 10000 = 0) Then 
      NewProgress = i / ByteLen * PROGRESS_CALCCRC + PROGRESS_CALCFREQUENCY 
      If (NewProgress <> CurrProgress) Then 

        CurrProgress = NewProgress 
        RaiseEvent Progress(CurrProgress) 
      End If 
    End If 

  Next 
  Result(ResultLen) = Char 
  ResultLen = ResultLen + 1 
   
  'Add the length of the source string to the 
  'header for corruption identification 
  Call CopyMem(Result(ResultLen), ByteLen, 4) 
  ResultLen = ResultLen + 4 

   
  'Create a small array to hold the bit values, 
  'this is faster than calculating on-fly 
  For i = 0 To 7 

    BitValue(i) = 2 ^ i 
  Next 
   
  'Store the number of characters used 
  Count = 0 
  For i = 0 To 255 
    If (CharValue(i).Count > 0) Then 
      Count = Count + 1 

    End If 
  Next 
  Call CopyMem(Result(ResultLen), Count, 2) 
  ResultLen = ResultLen + 2 

   
  'Store the used characters and the length 
  'of their respective bit sequences 
  Count = 0 
  For i = 0 To 255 
    If (CharValue(i).Count > 0) Then 
      Result(ResultLen) = i 
      ResultLen = ResultLen + 1 
      Result(ResultLen) = CharValue(i).Count 
      ResultLen = ResultLen + 1 
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      Count = Count + 16 + CharValue(i).Count 
    End If 
  Next 

   
  'Make room for the Huffman Tree in the 
  'destination byte array 
  ReDim Preserve Result(0 To ResultLen + Count \ 8) 

   
  'Store the Huffman Tree into the result 
  'converting the bit sequences into bytes 
  BitPos = 0 

  ByteValue = 0 
  For i = 0 To 255 
    With CharValue(i) 
      If (.Count > 0) Then 
        For j = 0 To (.Count - 1) 
          If (.Data(j)) Then ByteValue = ByteValue + BitValue(BitPos) 
          BitPos = BitPos + 1 
          If (BitPos = 8) Then 

            Result(ResultLen) = ByteValue 
            ResultLen = ResultLen + 1 
            ByteValue = 0 
            BitPos = 0 

          End If 
        Next 
      End If 
    End With 
  Next 
  If (BitPos > 0) Then 
    Result(ResultLen) = ByteValue 
    ResultLen = ResultLen + 1 

  End If 
   
  'Resize the destination string to be able to 
  'contain the encoded string 

  ReDim Preserve Result(0 To ResultLen - 1 + lLength) 
   
  'Now we can encode the data by exchanging each 
  'ASCII byte for its appropriate bit string. 
  Char = 0 
  BitPos = 0 
  For i = 0 To (ByteLen - 1) 
    With CharValue(ByteArray(i)) 

      For j = 0 To (.Count - 1) 
        If (.Data(j) = 1) Then Char = Char + BitValue(BitPos) 
        BitPos = BitPos + 1 
        If (BitPos = 8) Then 

          Result(ResultLen) = Char 
          ResultLen = ResultLen + 1 
          BitPos = 0 
          Char = 0 
        End If 
      Next 
    End With 
    If (i Mod 10000 = 0) Then 
      NewProgress = i / ByteLen * PROGRESS_ENCODING + PROGRESS_CALCCRC + 
PROGRESS_CALCFREQUENCY 



A - 18 

 

      If (NewProgress <> CurrProgress) Then 
        CurrProgress = NewProgress 
        RaiseEvent Progress(CurrProgress) 

      End If 
    End If 
  Next 
 

  'Add the last byte 
  If (BitPos > 0) Then 
    Result(ResultLen) = Char 
    ResultLen = ResultLen + 1 

  End If 
   
  'Return the destination in string format 
  ReDim ByteArray(0 To ResultLen - 1) 
  Call CopyMem(ByteArray(0), Result(0), ResultLen) 
 
  'Make sure we get a "100%" progress message 
  If (CurrProgress <> 100) Then 

    RaiseEvent Progress(100) 
  End If 
 
End Sub 

Public Function DecodeString(Text As String) As String 
   
  Dim ByteArray() As Byte 
   
  'Convert the string to a byte array 
  ByteArray() = StrConv(Text, vbFromUnicode) 
   
  'Compress the byte array 

  Call DecodeByte(ByteArray, Len(Text)) 
   
  'Convert the compressed byte array to a string 
  DecodeString = StrConv(ByteArray(), vbUnicode) 

   
End Function 
Public Function EncodeString(Text As String) As String 
   
  Dim ByteArray() As Byte 
   
  'Convert the string to a byte array 
  ByteArray() = StrConv(Text, vbFromUnicode) 

   
  'Compress the byte array 
  Call EncodeByte(ByteArray, Len(Text)) 
   

  'Convert the compressed byte array to a string 
  EncodeString = StrConv(ByteArray(), vbUnicode) 
   
End Function 
 
Public Sub DecodeByte(ByteArray() As Byte, ByteLen As Long) 
   
  Dim i As Long 
  Dim j As Long 
  Dim Pos As Long 



A - 19 

 

  Dim Char As Byte 
  Dim CurrPos As Long 
  Dim Count As Integer 

  Dim CheckSum As Byte 
  Dim Result() As Byte 
  Dim BitPos As Integer 
  Dim NodeIndex As Long 

  Dim ByteValue As Byte 
  Dim ResultLen As Long 
  Dim NodesCount As Long 
  Dim lResultLen As Long 

  Dim NewProgress As Integer 
  Dim CurrProgress As Integer 
  Dim BitValue(0 To 7) As Byte 
  Dim Nodes(0 To 511) As HUFFMANTREE 
  Dim CharValue(0 To 255) As ByteArray 
   
  If (ByteArray(0) <> 72) Or (ByteArray(1) <> 69) Or (ByteArray(3) <> 13) Then 
    'The source did not contain the identification 

    'string "HE?" & vbCr where ? is undefined at 
    'the moment (does not matter) 
  ElseIf (ByteArray(2) = 48) Then 
    'The text is uncompressed, return the substring 

    'Decode = Mid$(Text, 5) 
    Call CopyMem(ByteArray(0), ByteArray(4), ByteLen - 4) 
    ReDim Preserve ByteArray(0 To ByteLen - 5) 
    Exit Sub 
  ElseIf (ByteArray(2) <> 51) Then 
    'This is not a Huffman encoded string 
    Err.Raise vbObjectError, "HuffmanDecode()", "The data either was not compressed with HE3 
or is corrupt (identification string not found)" 

    Exit Sub 
  End If 
   
  CurrPos = 5 

     
  'Extract the checksum 
  CheckSum = ByteArray(CurrPos - 1) 
  CurrPos = CurrPos + 1 
   
  'Extract the length of the original string 
  Call CopyMem(ResultLen, ByteArray(CurrPos - 1), 4) 
  CurrPos = CurrPos + 4 

  lResultLen = ResultLen 
   
  'If the compressed string is empty we can 
  'skip the function right here 

  If (ResultLen = 0) Then Exit Sub 
   
  'Create the result array 
  ReDim Result(0 To ResultLen - 1) 
   
  'Get the number of characters used 
  Call CopyMem(Count, ByteArray(CurrPos - 1), 2) 
  CurrPos = CurrPos + 2 
   
  'Get the used characters and their 
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  'respective bit sequence lengths 
  For i = 1 To Count 
    With CharValue(ByteArray(CurrPos - 1)) 

      CurrPos = CurrPos + 1 
      .Count = ByteArray(CurrPos - 1) 
      CurrPos = CurrPos + 1 
      ReDim .Data(0 To .Count - 1) 

    End With 
  Next 
   
  'Create a small array to hold the bit values, 

  'this is (still) faster than calculating on-fly 
  For i = 0 To 7 
    BitValue(i) = 2 ^ i 
  Next 
   
  'Extract the Huffman Tree, converting the 
  'byte sequence to bit sequences 
  ByteValue = ByteArray(CurrPos - 1) 

  CurrPos = CurrPos + 1 
  BitPos = 0 
  For i = 0 To 255 
    With CharValue(i) 

      If (.Count > 0) Then 
        For j = 0 To (.Count - 1) 
          If (ByteValue And BitValue(BitPos)) Then .Data(j) = 1 
          BitPos = BitPos + 1 
          If (BitPos = 8) Then 
            ByteValue = ByteArray(CurrPos - 1) 
            CurrPos = CurrPos + 1 
            BitPos = 0 

          End If 
        Next 
      End If 
    End With 

  Next 
  If (BitPos = 0) Then CurrPos = CurrPos - 1 
   
  'Create the Huffman Tree 
  NodesCount = 1 
  Nodes(0).LeftNode = -1 
  Nodes(0).RightNode = -1 
  Nodes(0).ParentNode = -1 

  Nodes(0).Value = -1 
  For i = 0 To 255 
    Call CreateTree(Nodes(), NodesCount, i, CharValue(i)) 
  Next 

   
  'Decode the actual data 
  ResultLen = 0 
  For CurrPos = CurrPos To ByteLen 
    ByteValue = ByteArray(CurrPos - 1) 
    For BitPos = 0 To 7 
      If (ByteValue And BitValue(BitPos)) Then 
        NodeIndex = Nodes(NodeIndex).RightNode 
      Else 
        NodeIndex = Nodes(NodeIndex).LeftNode 



A - 21 

 

      End If 
      If (Nodes(NodeIndex).Value > -1) Then 
        Result(ResultLen) = Nodes(NodeIndex).Value 

        ResultLen = ResultLen + 1 
        If (ResultLen = lResultLen) Then GoTo DecodeFinished 
        NodeIndex = 0 
      End If 

    Next 
    If (CurrPos Mod 10000 = 0) Then 
      NewProgress = CurrPos / ByteLen * PROGRESS_DECODING 
      If (NewProgress <> CurrProgress) Then 

        CurrProgress = NewProgress 
        RaiseEvent Progress(CurrProgress) 
      End If 
    End If 
  Next 
DecodeFinished: 
 
  'Verify data to check for corruption. 

  Char = 0 
  For i = 0 To (ResultLen - 1) 
    Char = Char Xor Result(i) 
    If (i Mod 10000 = 0) Then 

      NewProgress = i / ResultLen * PROGRESS_CHECKCRC + PROGRESS_DECODING 
      If (NewProgress <> CurrProgress) Then 
        CurrProgress = NewProgress 
        RaiseEvent Progress(CurrProgress) 
      End If 
    End If 
  Next 
  If (Char <> CheckSum) Then 

    Err.Raise vbObjectError, "clsHuffman.Decode()", "The data might be corrupted (checksum did 
not match expected value)" 
  End If 
 

  'Return the uncompressed string 
  ReDim ByteArray(0 To ResultLen - 1) 
  Call CopyMem(ByteArray(0), Result(0), ResultLen) 
   
  'Make sure we get a "100%" progress message 
  If (CurrProgress <> 100) Then 
    RaiseEvent Progress(100) 
  End If 

   
End Sub 
Private Sub CreateBitSequences(Nodes() As HUFFMANTREE, ByVal NodeIndex As Integer, 
Bytes As ByteArray, CharValue() As ByteArray) 

 
  Dim NewBytes As ByteArray 
   
  'If this is a leaf we set the characters bit 
  'sequence in the CharValue array 
  If (Nodes(NodeIndex).Value > -1) Then 
    CharValue(Nodes(NodeIndex).Value) = Bytes 
    Exit Sub 
  End If 
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  'Traverse the left child 
  If (Nodes(NodeIndex).LeftNode > -1) Then 
    NewBytes = Bytes 

    NewBytes.Data(NewBytes.Count) = 0 
    NewBytes.Count = NewBytes.Count + 1 
    Call CreateBitSequences(Nodes(), Nodes(NodeIndex).LeftNode, NewBytes, CharValue) 
  End If 

   
  'Traverse the right child 
  If (Nodes(NodeIndex).RightNode > -1) Then 
    NewBytes = Bytes 

    NewBytes.Data(NewBytes.Count) = 1 
    NewBytes.Count = NewBytes.Count + 1 
    Call CreateBitSequences(Nodes(), Nodes(NodeIndex).RightNode, NewBytes, CharValue) 
  End If 
   
End Sub 
 
Private Function FileExist(Filename As String) As Boolean 

 
  On Error GoTo FileDoesNotExist 
   
  Call FileLen(Filename) 

  FileExist = True 
  Exit Function 
   
FileDoesNotExist: 
  FileExist = False 
   
End Function 
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Relay  

A relay is an electromagnetic switch. Applying current causes the electromagnet to become active 

and pull the contacts together. On the schematic, the electromagnet is the part of the symbol that 

looks like half a transformer or inductor. The contacts are right beside (or above or below) the coil. 

These contacts can take on any of the normal switch configurations. Pictured here is a simple 

SPST (or Single Pole Single Throw) relay. This means the the Relay contains one set of contacts 

and can only be switched one way (on or off). Other types of relays include SPDT (Single Pole 

Double Throw-A relay with one contact that can be toggled both ways), DPST (Double Pole 

Single Throw-A relay with two contacts that can only be on or off) and DPDT (Double Pole 

Double Throw-A relay with two contacts that can be toggled both ways).  

-------------------------------------------------------------------------------- 

 

 

Dynamic Microphone  

A microphone is a device that translates sound waves into varying electrical current. A dynamic 

microphone is a microphone that uses a small coild moved through a magnetic field to generate a 

voltage that varies as the sound varies. The coil is attached to a small diaphram, which vibrates 

with the sound waves.  

-------------------------------------------------------------------------------- 

. 

. 

. 

Meter  

A meter measures electricity. It does this by using a coil to pivot a needle. The coil is mounted to 

one end of the needle and sits between the poles of a U shaped magnet. When a current is applied, 

the coil will rotate. This rotation causes the neetle to pivot. The amount of coil rotation depends on 

the amount of current flowing through it. The symbol for meters may take on many forms, but the 

type of the meter is always specified in the parts list or on the schematic. Common types of meters 

are voltmeters (measures voltage), ammeters (measures current) and wattmeters (measures power).  

-------------------------------------------------------------------------------- 

 

 

Solenoid  

A solenoid is a sucking magnet. Applying current causes a hollow coil of wire to suck in a iron 

rod. This rod can be connected to anything that must be pulled. Solenoids are used in cars, tape 

players, VCRs, hard drives and almost any electromechanical device. 
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Universal Serial Bus (USB) adalah standar bus berseri untuk perangkat penghubung, biasanya 

kepada komputer namun juga digunakan di peralatan lainnya seperti konsol permainan dan PDA. 

Sistem USB mempunyai desain yang asimetris, yang terdiri dari pengontrol host dan beberapa 

peralatan terhubung yang berbentuk pohon dengan menggunakan peralatan hub yang khusus. 

Desain USB ditujukan untuk menghilangkan perlunya penambahan expansion card ke ISA 

komputer atau bus PCI, dan memperbaiki kemampuan plug-and-play (pasang-dan-mainkan) 

dengan memperbolehkan peralatan-peralatan ditukar atau ditambah ke sistem tanpa perlu 

mereboot komputer. 

Ketika USB dipasang, ia langsung dikenal sistem komputer dan memroses device driver yang 

diperlukan untuk menjalankannya.USB dapat menghubungkan peralatan tambahan komputer 

seperti mouse, keyboard, pemindai gambar, kamera digital, printer, hard disk, dan komponen 

networking. 

USB kini telah menjadi standar bagi peralatan multimedia seperti pemindai gambar dan kamera 

digital.Versi terbaru (hingga Januari 2005) USB adalah versi 2.0. Perbedaan paling mencolok 

antara versi baru dan lama adalah kecepatan transfer yang jauh meningkat. 

Kecepatan transfer data USB dibagi menjadi tiga, antara lain: 

High speed data dengan frekuensi clock 480.00Mb/s dan tolerasi pensinyalan data pada ± 500ppm. 

Full speed data dengan frekuensi clock 12.000Mb/s dan tolerasi pensinyalan data pada ±0.25% 

atau 2,500ppm. 

Low speed data dengan frekuensi clock 1.50Mb/s dan tolerasi pensinyalan data pada ±1.5% atau 

15,000ppm. 

. 

. 

. 

ENDP (End point)  

Titik akhir dari field yang terdiri dari 4 bit, menjadikan 16 kemungkinan titik akhir. Low speed 

devices, hanya dapat mempunyai 2 tambahan end point pada puncak dari pipe default. (maksimal 

4 endpoints) 

 

CRC  

Cyclic Redundancy Check dijalankan pada data didalam paket yang dikirim. Semua penanda 

(token) paket mempunyai sebuah 5 bit CRC ketika paket data mempunyai sebuah 16 bit CRC. 

EOP (End of packet)  

Akhir dari paket yang disinyalkan dengan satu angka akhir 0 (Single Ended Zero/SEO) untuk kira-

kira 2 kali bit diikuti oleh sebuah J 1 kali. 

Data yang dikirim dalam bus USB adalah salah satu dari 4 bentuk, yaitu control, interrupt, bulk, 

atau isochronous. 
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      The MathWorks, Inc. Software License Agreement 

 

Licensee may receive a full refund if within thirty (30) days  

from the date of delivery (the "Acceptance Period") Licensee  

does not accept the terms and conditions of this License and the  

applicable Addendum, or if Licensee terminates this License for  

any reason, within the Acceptance Period.  

  

LICENSE GRANT.  The MathWorks, Inc. ("MathWorks") hereby grants  

to Licensee a nonexclusive License to install and use the  

Programs and accompanying Documentation as provided herein.  The  

licensed Programs and Documentation shall at all times remain  

the property of MathWorks and/or its Licensors, and Licensee  

shall have no right, title, or interest therein, except as  

expressly set forth in this Agreement. 

. 

. 

. 

9. General 

 

Licensee acknowledges that a material breach of the obligations  

set forth in this Addendum, which have not been cured within  

sixty (60) days of written notification from MathWorks, shall be  

grounds for termination as provided in the Agreement. 

 

This Addendum is an Addendum to The MathWorks, Inc. Software  

License Agreement, the terms and conditions of which are  

incorporated herewith. Each capitalized term used herein and not  

defined herein shall have the meaning described to it in the  

Agreement. 

 

 

                                                       05/24/02 
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Football Manager 2008 v8.0.2 (Build xxxxx) 

------------------------------------------ 

 

General 

============ 

- Injured players will not get offered out on loan by parent clubs 

- Human gets taken to the competition news screen on big events such as yearly award news items 

- Ensured AI replaces overage captains promptly 

- When Hearts play Hibs, both teams can now play in their first kits. 

- Awards news no longer always refers to manager award winners and runners-up as having 

"nothing to choose between them" 

- Stopped duplicate player appearing in Best Eleven if the same player is loaned twice by the club 

- Stopped players being unahppy when an international captain is replaced following his retirement 

- Fixed post match key man watch comments not mentioning player being injured/sent off/subbed 

etc 

- Changed turkish regens to always be turkish by first nationality and have small chance of a 

specific second nationality 

. 

. 

. 

Match v663 

=========== 

- Fixed v662 bug where players stop in their tracks and let ball player go 

- Tweaked AI mentality slider ( applies to FM 8.0.2 only ) 

- Tweaked effect of consistency attribute a little ( a few more off days ) 

- Fixed bug where defenders may commit foul in area when ball nowhere near 

- Fixed v662 bug where player marking ball player sometimes drops off suddenly and illogically 

- Tried to eradicate more instances of players stopping on ball and being caught in possession 

- Reduced ability of players to change direction with ball at high speed 

- Stopped team all out attack setting overriding goalie mentality and sending him forward for 

corners late on 

- Made players move towards ball that is theirs for the taking ( broken in 661 ) 

- Fixed bug where player set to man mark specific player would drop way deeper than his 

defensive line 

- Made attacking teams a little more adventurous with passing in safe areas 

- Reduced instances of refs giving fouls mistakenly when player clearly gets the ball 

- Tweaked keeper ratings down a little 
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Steganography is the art and science of writing hidden messages in such a way that no one apart 

from the intended recipient knows of the existence of the message; this is in contrast to 

cryptography, where the existence of the message itself is not disguised, but the content is 

obscured. Quite often, steganography is hidden in pictures. 

 

The word "Steganography" is of Greek origin and means "covered, or hidden writing". Its ancient 

origins can be traced back to 440 BC. Herodotus mentions two examples of Steganography in The 

Histories of Herodotus [1]. Demeratus sent a warning about a forthcoming attack to Greece by 

writing it on a wooden panel and covering it in wax. Wax tablets were in common use then as re-

usable writing surface, sometimes used for shorthand. Another ancient example is that of 

Histiaeus, who shaved the head of his most trusted slave and tattooed a message on it. After his 

hair had grown the message was hidden. The purpose was to instigate a revolt against the Persians. 

Later, Johannes Trithemius's book Steganographia is a treatise on cryptography and steganography 

disguised as a book on black magic. 

 

Generally, a steganographic message will appear to be something else: a picture, an article, a 

shopping list, or some other message. This apparent message is the covertext. For instance, a 

message may be hidden by using invisible ink between the visible lines of innocuous documents.. 

. 

. 

. 

From an information theoretical point of view, this means that the channel must have more 

capacity than the 'surface' signal requires, that is, there must be redundancy. For a digital image, 

this may be noise from the imaging element; for digital audio, it may be noise from recording 

techniques or amplification equipment. In general, electronics that digitize an analog signal suffer 

from several noise sources such as thermal noise, flicker noise, and shot noise. This noise provides 

enough variation in the captured digital information that it can be exploited as a noise cover for 

hidden data. In addition, lossy compression schemes (such as JPEG) always introduce some error 

into the decompressed data; it is possible to exploit this for steganographic use as well. 

 

Steganography can be used for digital watermarking, where a message (being simply an identifier) 

is hidden in an image so that its source can be tracked or verified. 

 

In the era of digital video recorders and devices like TiVo, TV commercials authors have figured 

out how to make use of such devices as well - by putting a hidden message which becomes visible 

when played at frame-by-frame speed (see KFC Unveils 'TiVo-proof' Ad). 
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AND Gate  

Gates are the building blocks that all digital integrated circuits are built on. Gates are simple 

circuits that perform logical opetations. A AND gate is a gate whose output goes to a digital 1 (or 

on, or high, etc.) when both inputs are 1. On the schematic, the inputs are the two connections on 

the flat side of the symbol. The output is the connection on the rounded part. The inputs are 

usually refered to as A and B. A is on the top. Remember that with gates, the symbol always points 

towards the outputs. The truth table for an AND gate is shown below:  

A B Output  

0 0 0  

1 0 0  

1 1 1  

0 1 0  

 

-------------------------------------------------------------------------------- 

 

 

NAND Gate  

Gates are the building blocks that all digital integrated circuits are built on. Gates are simple 

circuits that perform logical opetations. A NAND gate is a gate whose output goes to a digital 0 (or 

off, or low, etc.) when both inputs are 1. On the schematic, the inputs are the two connections on 

the flat side of the symbol. The output is the connection on the rounded part. The inputs are 

usually refered to as A and B. A is on the top. Remember that with gates, the symbol always points 

towards the outputs. The truth table for an NAND gate is shown below:  

. 

. 

. 

1 1 Toggle  

0 1 0 1  

 

-------------------------------------------------------------------------------- 

 

 

T Flip Flop  

A flip flop is a gate whose output(s) alternate between 1 and 0 with input pulses. In the case of an 

T flip flop, the Q and NOT Q (the Q with the line over it) alternate with pulses on the T line. For 

example, the first pulse will cause Q to go high and NOT Q to go low. On the second pulse, Q 

goes low and NOT Q goes high. The cycle repeats with every pulse. 
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CatalogDB: 9:10:17 AM 8/25/2007: Adding Catalog File:  NT5INF.CAT 

CatalogDB: 9:10:17 AM 8/25/2007: DONE Adding Catalog File:  NT5INF.CAT 

CatalogDB: 9:10:18 AM 8/25/2007: Adding Catalog File:  NT5.CAT 

CatalogDB: 9:10:19 AM 8/25/2007: DONE Adding Catalog File:  NT5.CAT 

CatalogDB: 9:10:19 AM 8/25/2007: Adding Catalog File:  SP2.CAT 

CatalogDB: 9:10:20 AM 8/25/2007: DONE Adding Catalog File:  SP2.CAT 

CatalogDB: 9:10:21 AM 8/25/2007: Adding Catalog File:  NTPRINT.CAT 

CatalogDB: 9:10:21 AM 8/25/2007: DONE Adding Catalog File:  NTPRINT.CAT 

CatalogDB: 9:10:22 AM 8/25/2007: Adding Catalog File:  NT5IIS.CAT 

CatalogDB: 9:10:22 AM 8/25/2007: DONE Adding Catalog File:  NT5IIS.CAT 

CatalogDB: 9:10:22 AM 8/25/2007: Adding Catalog File:  MAPIMIG.CAT 

CatalogDB: 9:10:22 AM 8/25/2007: DONE Adding Catalog File:  MAPIMIG.CAT 

CatalogDB: 9:10:22 AM 8/25/2007: Adding Catalog File:  FP4.CAT 

CatalogDB: 9:10:22 AM 8/25/2007: DONE Adding Catalog File:  FP4.CAT 

CatalogDB: 9:10:23 AM 8/25/2007: Adding Catalog File:  IMS.CAT 

CatalogDB: 9:10:23 AM 8/25/2007: DONE Adding Catalog File:  IMS.CAT 

CatalogDB: 9:10:23 AM 8/25/2007: Adding Catalog File:  MSMSGS.CAT 

CatalogDB: 9:10:23 AM 8/25/2007: DONE Adding Catalog File:  MSMSGS.CAT 

. 

. 

. 

CatalogDB: 3:19:22 AM 6/13/2008: DONE Adding Catalog File:  oem21.CAT 

CatalogDB: 3:19:29 AM 6/13/2008: Adding Catalog File:  KB950759-IE7.cat 

CatalogDB: 3:19:29 AM 6/13/2008: DONE Adding Catalog File:  KB950759-IE7.cat 

CatalogDB: 9:17:40 PM 6/16/2008: File #1 at line #5629 encountered error 0x8e5e0408 

CatalogDB: 9:17:40 PM 6/16/2008: File #1 at line #2789 encountered error 0x8e5e0408 

CatalogDB: 9:17:40 PM 6/16/2008: File #1 at line #1687 encountered error 0x8e5e0408 

CatalogDB: 9:17:40 PM 6/16/2008: File #3 at line #274 encountered error 0x8e5e0408 

CatalogDB: 9:17:40 PM 6/16/2008: File #2 at line #2371 encountered error 0x8e5e0408 

CatalogDB: 9:17:40 PM 6/16/2008: File #2 at line #1057 encountered error 0x8e5e0408 

CatalogDB: 3:25:28 PM 7/2/2008: File #2 at line #1436 encountered error 0x800b0003 

CatalogDB: 9:26:27 PM 7/7/2008: File #1 at line #5629 encountered error 0x8e5e0408 

CatalogDB: 9:26:27 PM 7/7/2008: File #1 at line #2789 encountered error 0x8e5e0408 

CatalogDB: 9:26:27 PM 7/7/2008: File #1 at line #1687 encountered error 0x8e5e0408 

CatalogDB: 9:26:27 PM 7/7/2008: File #3 at line #274 encountered error 0x8e5e0408 

CatalogDB: 9:26:27 PM 7/7/2008: File #2 at line #2371 encountered error 0x8e5e0408 

CatalogDB: 9:26:27 PM 7/7/2008: File #2 at line #1057 encountered error 0x8e5e0408 
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 Acer Aspire 4720Z 

 

Intel Pentium dual-core mobile processor T2370 

(1MB L2 cache, 1.73GHz, 533Mhz FSB) 

14.1" Widescreen XGA Acer CrystalBrite TFT LCD 

(1289x800 pixel) 

IEEE 3945 port 

Dolby Surround Sound System 

512MB DDR2 

120GB SATA HDD 

Gigabit LAN 

5-in-1 Media Reader 

DVD Super Multi Double Layer Drive 

ExpressCard slot 

TV-Out 

Acer Crytsal Eye webcam 

Wireless LAN 802.11b/g 

LINUX BE (Basic Edition) Operating System 

. 

. 

. 

Intel Pentium dual-core mobile processor T5240 

(1MB L2 cache, 1.83GHz, 533Mhz FSB) 

15" Widescreen XGA Acer CrystalBrite TFT LCD 

(1289x800 pixel) 

IEEE 3945 port 

Dolby Surround Sound System 

1024sMB DDR2 

250GB SATA HDD 

Gigabit LAN 

5-in-1 Media Reader 

DVD Super Multi Double Layer Drive 

ExpressCard slot 

TV-Out 

Acer Crytsal Eye webcam 

Wireless LAN 802.11b/g 

LINUX BE (Basic Edition) Operating System 
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File 9 

"Task Scheduler Service" 

 Exited at 9/7/2008 5:40:04 PM 

"Task Scheduler Service" 

 Started at 9/8/2008 11:03:50 AM 

"Check Updates for Windows Live Toolbar.job" (MSNTBUP.EXE) 

 Started 9/8/2008 11:16:00 AM 

"Check Updates for Windows Live Toolbar.job" (MSNTBUP.EXE) 

 Finished 9/8/2008 11:22:31 AM 

 Result: The task completed with an exit code of (0). 

"Check Updates for Windows Live Toolbar.job" (MSNTBUP.EXE) 

 Started 9/8/2008 12:16:00 PM 

"Check Updates for Windows Live Toolbar.job" (MSNTBUP.EXE) 

 Finished 9/8/2008 12:23:43 PM 

 Result: The task completed with an exit code of (0). 

"Check Updates for Windows Live Toolbar.job" (MSNTBUP.EXE) 

 Started 9/8/2008 1:16:00 PM 

"Check Updates for Windows Live Toolbar.job" (MSNTBUP.EXE) 

 Finished 9/8/2008 1:22:30 PM 

 Result: The task completed with an exit code of (0). 

. 

. 

. 

"Check Updates for Windows Live Toolbar.job" (MSNTBUP.EXE) 

 Started 9/7/2008 3:16:00 PM 

"Check Updates for Windows Live Toolbar.job" (MSNTBUP.EXE) 

 Finished 9/7/2008 3:22:30 PM 

 Result: The task completed with an exit code of (0). 

"Check Updates for Windows Live Toolbar.job" (MSNTBUP.EXE) 

 Started 9/7/2008 4:16:00 PM 

"Check Updates for Windows Live Toolbar.job" (MSNTBUP.EXE) 

 Finished 9/7/2008 4:22:29 PM 

 Result: The task completed with an exit code of (0). 

"Check Updates for Windows Live Toolbar.job" (MSNTBUP.EXE) 

 Started 9/7/2008 5:16:00 PM 

"Check Updates for Windows Live Toolbar.job" (MSNTBUP.EXE) 

 Finished 9/7/2008 5:22:30 PM 

 Result: The task completed with an exit code of (0). 
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File 10 

On the Insert tab, the galleries include items that are designed to coordinate with the overall look 

of your document. 

You can use these galleries to insert tables, headers, footers, lists, cover pages, and other document 

building blocks. 

When you create pictures, charts, or diagrams, they also coordinate with your current document 

look. 

You can easily change the formatting of selected text in the document text by choosing a look for 

the selected text from the Quick Styles gallery on the Home tab. 

You can also format text directly by using the other controls on the Home tab. 

Most controls offer a choice of using the look from the current theme or using a format that you 

specify directly. 

To change the overall look of your document, choose new Theme elements on the Page Layout 

tab. 

To change the looks available in the Quick Style gallery, use the Change Current Quick Style Set 

command. 

Both the Themes gallery and the Quick Styles gallery provide reset commands so that you can 

always restore the look of your document to the original contained in your current template. 

On the Insert tab, the galleries include items that are designed to coordinate with the overall look 

of your document. 

. 

. 

. 

You can use these galleries to insert tables, headers, footers, lists, cover pages, and other document 

building blocks. 

When you create pictures, charts, or diagrams, they also coordinate with your current document 

look. 

You can easily change the formatting of selected text in the document text by choosing a look for 

the selected text from the Quick Styles gallery on the Home tab. 

You can also format text directly by using the other controls on the Home tab. 

Most controls offer a choice of using the look from the current theme or using a format that you 

specify directly. 

To change the overall look of your document, choose new Theme elements on the Page Layout 

tab. 

To change the looks available in the Quick Style gallery, use the Change Current Quick Style Set 

command. 

Both the Themes gallery and the Quick Styles gallery provide reset commands so that you can 

always restore the look of your document to the original contained in your current template. 
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